ES - TLT 368, Summer 2012 - Course record
Navigation short-cut: Session jump by number
1 - 2 - 3 - 4 - 5 - 6 - 7 - 8 - 9 - 10 - 11 - 12 ... end
Session 1 - Tuesday, 22 May
Before class
If you can, get into CourseSite and poke around
During class (ppt)
Introductions
Going through the first part of the syllabus
Online resources for you to use
Software tools–things you might want to download are here.
Going through second half of syllabus: Assignments we'll be doing
Topics of interest in this course
Guiding principles for the course
Activity: Where should we place the SuperMart?
Image set
Overview of all four proposed locations
Location A
Location B
Location C
Location D
(If you prefer: Google Earth overlay of all four locations)
(If you want to see this activity in the context of the full unit on Land Use Change, it's part of the Environmental Literacy & Inquiry project.)
Back to "Topics of interest"
Closure
After class
Reading
Bodzin & Cirucci, 2009
Broda & Baxter, 2003
Optional: Snyder & Hammond, 2012
Assignments
WTL
Brainstorm topics for projects
Download and mess around with software.
Session 2 - Thursday, 24 May
Before class
Come to class prepared to go outside!! Dress accordingly!
Do reading, etc.
During class (ppt)
Housekeeping–corrected links; examining calendar; Google Earth proof-of-concept due June 5.
Let's go outside! Scaffolded geocaching
De-brief of activity
(Non-scaffolded geocaching: Check out caches near Iacocca Hall...some of them VERY near.)
Google Earth how-to: You've collected your data, now what?
Example of a Google Earth project I'm fiddling with: Energy extraction in Pennsylvania – here's my current draft of the file.
Examples of K-12 instructional sequences using student data collection
Calypso
Broughal: Online resources here.
Stream monitoring
Closure
After class
Reading
Bodzin, Hammond, Carr, & Calario, 2009
Hammond & Bodzin, 2009
Optional: Bodzin, 2008
Optional: Golledge, 1995 (spatial thinking)
Assignments
Download and try out AEJEE and MyWorld
Read and respond to a classmate's assignment ideas.
WTL
Session 3 - Tuesday, 29 May

Before class
Complete reading
Start working on Google Earth assignment
Download and play around with GIS. You don't have to have AEJEE, but it's a free tool that lets you take a look at the world of Esri products
During class (ppt)
Housekeeping
Everyone is launched in CourseSite -- don't forget to keep up with WTL
How is everyone for software?
Google Earth
AEJEE
My World (using trial download)
Sign up for meeting times next Tues.
Opening discussion of assignments: What do you have in mind for your Google Earth assignment?
Conceptual work: Getting started in Google Earth, AEJEE, and My World
Organizing framework for geospatial tools: LINIQES: Load, interface, navigate, inspect, query, edit, save
Google Earth
Load
Mix of client-side and server-side data.
Satellite imagery: What are we looking at? Mix of current and dated material (see imagery date in lower left);
it's only as good as "they" let you have (e.g., contrast One Observatory Circle vs. 1600 Pennsylvania Ave.
NW)
Layers -- my recommendation is to turn OFF as much as possible. But I do like leaving 3-D buildings on...
sometimes turns up fun surprises (for example, Amsterdam!).
File > Open to load a .kml or a .kmz. For our demo, we'll use this file that I created for TLT 406. It's interesting
b/c it has points, lines, associated images, etc.
Interface
Sidebar vs. display area vs. toolbar
Sidebar on and off
Navigation tools on, off, or auto
Sidebar fields: Search, My Places, Layers
Navigate
Search box, or
Double-click on an item in a list (Search or My Places)
Double-click on any point on the globe to go there.
Navigation tools: Tilt/pan, move NSEW, zoom in/out
Inspect
Single-click to open up info box.
Right-click and select "Properties" or "Get Info" -- gives more access to point/line/polygon data (e.g., lat/lon,
URL of any imported images). More importantly, you can EDIT items in this mode (see below)
Query
Actually, not much we can do here beyond typing in search terms.
Some of the other tools are handy--use the ruler to measure, use the time-of-day feature to look at shadows,
historical imagery to see earlier images, and the newest Easter egg that I've found: Show elevation profile
(draw a path and right-click it!)
(And of course Google Earth is not just Earth -- View > Explore gives you options of Earth, Sky, Moon, and
Mars!)
Edit
Add something new: either
Search for it and then drag it into My Places and work on it, or
Click on Add Placemark, Add Polygon, or Add Path.
Editing something once it's been created: Open up Properties (or Info) and modify.
Save
For our purposes: Right-click the item, folder, or file name and "Save Place As"
You can also
Save out snapshopts
Record a tour
Move into Google Maps
AEJEE - Note that this runs on Java, so it requires a Java Runtime Environment...and some patience.
Load
All client-side data. We'll start by loading a blend of demo, downloaded, and self-generated data.
Loading demo data: File > open > us_hd.axl. (In case you need to browse to this: The file path is
ESRI\AEJEE\Data.) What you're looking at: spreadsheets rendered visually. But we'll get to this in
"Inspect"
Interface
Similar to Google Earth: tools across the top, left-hand layers, main area = display
Note importance of layers
Turn on/off
Re-order (e.g., pull cities layer down in the stack)
Navigate: Move about the map in at least three ways
Drag the map around
Zoom in/out
Zoom to full extent or active layer
BEWARE getting zoomed in or out too far -- correct using "Zoom to" tools (select layer and then zoom to it)
Inspect
Identify tool ('i') -- can be hard to use unless you're properly zoomed in.
Finder (Binoculars)

Try looking in the 'cities' layer for 'Denver'
Repeat this for 'San' -- select all the results and look at them on the map. What was expected? What
was a surprise?
Query
Query-builder: Try POP_CLASS = 10. Repeat with POP_CLASS = 9, POP_CLASS >= 9
Table of results and displays on map.
Edit
Modify visuals
Right-click cities and select 'Properties'
Code cities by POP_CLASS, all one size, use color to differentiate ranks (e.g., red for highest rank -largest cities -- and green for lowest rank)
Right-click states and select 'Properties'
Bring up 'Labels' tab and select STATE_NAME
Modify data -- all done in spreadsheet editor
Add new fields to existing layers: add a column, don't make the new column name more than 10
characters! Save as tab-delimited text
Creating new layers: MUST edit outside of AEJEE, bring it in.
Can add point data fairly easily -- just give it a lat and a lon
Adding lines or polygons is much trickier. Take a look at the demo files of 10grid_hd.axl and
10gridpn_hd.axl to get a sense of this.
Save
Saves out as ArcXML (axl) files; viewable in Arc products.
HOWEVER: Note that each project file is pretty tiny (just a couple kilobytes) -- they're referencing the REAL
data sources, down in the data folders. So if you're trying to move data around, move both the project file and
the data sources.
Transitioning from AEJEE to My World: Just to demo the limitations of AEJEE, let's load some non-demo data
Here are files with the streets for our immediate surroundings. Note that part of the challenge in using AEJEE is just
file management....
Lehigh County streets
Lehigh shp
Lehigh shx
Lehigh dbf
Northampton Country streets
Northampton shp
Northampton shx
Northampton dbf.
WHAT TO DO WITH THESE FILES
Download them all to the same folder / location, make sure you know how to find them.
Hit the "Add data..." button (between 'Print' and 'Remove layer') and browse to where you stored the data;
you should see the .shp files there. Select them and they will become new layers.
And here is our scaffolded geocache data as tab-delimited text. Save this file to your machine, then do View >
Add Event Theme. Browse to where the .txt file is, select it. BE SURE to specify 'lon' as the X Field, and 'lat'
as the Y field.
Given that this is pretty boring (b/c we can't see Iacocca Hall -- we don't have the satellite image here, and we
don't have a polygon for Iacocca), you can also look at some (very dirty) sewer data for the Southside:
sewers.txt (htp://coexs.dept.lehigh.edu:16080/~tch207/broughal_geospatial/data/sewers.txt), same process
as before.
My World
Load
Here, everything is built in: The "Construct" tab is where you assemble your data. You can add your own
custom data, but for the moment, just
Set the Library to "United States"
Pull the following to the "Layer List" column: U.S. States, Counties, Rivers, Major Highways -whatever you like.
To get our geocache data: Do File > Import Layer From File. Browse to wherever you stored the file,
and note that this program is a little smarter -- given lat and lon, it recognizes them automatically.
Interface: You have the usual menus, but the tabs are the key
"Construct" is where you assemble the dataset
"Visualize" gets you more screen space and lets you see what's in each data layer. This is also a good place
to re-order / re-stack layers, adjust colors, icons, turn layers on/off, etc. (You can do these in "Construct" as
well, but you'll have a more cramped screen.)
"Analyze" is where you run your queries.
"Edit" lets you change your data set or add new layers from your own data.
Navigation:
The same tools and concepts apply: drag, zoom, zoom-to-active
Important new tool: Step forward / step back among views
Inspect: You still have an Inspect tool, but you can do a lot more browsing using the records fields to the right.
Query
This is actually pretty different: The Analyze tab is where you do this, and it's all split out by function. Note
that this tool lets you do a lot of math (calculations, graphs) as well as maps. For example: Figure out a series
of steps to see if the %age of older persons really is higher in Florida, Arizona, etc.
Another bit of added value: You can save your queries / analyses as new layers. For students, this is VERY
handy.
Edit
Obviously, the Edit tab is the place to be. Double-click on a layer and you can see the spreadsheet, add new
records (entries) or new fields (characteristics to existing records).
Time permitting: Example of adding new data to an existing data file: I've done a little work moving
some Holocaust data into GIS. Sources are these two graphs from Yad Vashem: 1, 2.

You can make an entirely new layer (points, lines, polygons, etc.) by clicking the "Create A New, Empty
Layer" button (the sheet-of-paper looking thing)
Save
The important thing here is to do "Save Project As..." to preserve (a) the integrity of the original data, and (b)
whatever changes / analyses you've made.
Closure: More thinking about assignments
After class
Reading
Doering & Veletsianos, 2007
Edelson, 2004
Assignments
WTL
Work on Google Earth assignment
If you haven't already: Sign up for meeting times next Tues.
Session 4 - Thursday, 31 May – canceled
Before class
Complete reading
During class (ppt)
Housekeeping
Conceptual work
Closure
After class
Reading
Assignments
Session 5 - Tuesday, 5 June
Before class
Complete the reading. Note that there's nothing new to add – just do the follow-up readings from our last meeting on Tues, 29 May
Complete and turn in your Google Earth proof-of-concept. This is basically just one or more Google Earth files that gets started on your concept,
plus a note (either in the CourseSite upload's comment box or in an accompanying text document – I don't care) on what you intend to do to finish
things off.
During class (ppt)
4:00-4:30 = OPTIONAL PRESENTATION. Topic = Finding data
A GIS is only as good as its data
Data structure: The map (.shp), the fields (.dbf), and the glue between the two (an index of map and fields: shx)
Data-searching
It's a mess. Case-in-point: Federal Geographic Data Committee. Aim = "'one-stop'access to all registered geographic
information and related online access services within the United States." Their portal (gos2.geodata.gov as of this writing)
doesn't load. Best case scenario = hit-or-miss
US = most data-rich environment; Europe also pretty good. China = black hole. Other parts of the world: Data exists for some
topics, depending on if a govt or NGO has taken an interest.
My master list = http://delicious.com/tchammond/dataSources+TLT394, but we can break it down for a little additional clarity.
Finding maps
Advice
First, know what's in the built-in libraries for My World, AEJEE, ArcGIS, etc. In general, you can get a map from any
one system into another
Things to know about going in: Map projections. Unfortunately, I don't have any slick suggestions with this. Just pay
attention to the documentation, play around with it to get it to work. Or else cross your fingers and hope you get lucky.
Strategies
Census Bureau maps: http://delicious.com/tchammond/dataSources+census+maps – heavy on the built environment
that's related to population (e.g., street grid), not so good for other topics.
Regional agencies: http://delicious.com/tchammond/dataSources+regional More idiosyncratic in terms of focus and
datasets available. State-level usually has at least one agency looking at environmental issues. If someone gets a
good lead on additional state-level data, let me know so I can add to the list!!
Historical atlases: If you need a map that does NOT reflect the current political or natural geography, it's seriously hitor-miss. http://delicious.com/tchammond/dataSources+maps+historical
Raid other people's projects: http://delicious.com/tchammond/dataSources+projects
Finding fields
Advice
Again, pay attention to what's in the built-in data for your software.
Things to know about going in: You might get the data in a spreadsheet, not a GIS file. You then play with it to get it
into your GIS, but that's a second step. First, just get your hands on it; worry about how to import and display it later.
Strategies
Census sources: http://delicious.com/tchammond/dataSources+census+fields
Again, looking at other people's projects and building on them: http://delicious.com/tchammond/dataSources+projects
Brute force and ignorance: You find the data in whatever format, you wrangle it into your GIS
Find some data and type it into your GIS in editing mode (e.g., http://delicious.com/tchammond/YadVashem) .

Find other someone's Google Earth coverage and re-construct into GIS. It's generally a tremendous pain to
move from GE to GIS, but it can be done. For example: I took this file (http://www.cwoodcock.com
/Civil_War_by_Campaign.kmz) and with a LOT of editing in Excel got it into ArcMap.
Closure: Very much a topic in evolution. I learn from others (e.g., Shannon White: http://www.geog.missouri.edu/grad/white.html – see her
delicious list at http://delicious.com/shwhite...it has 3500+ links!!). Talk it through, support one another, browse the master list (http://delicious.com
/tchammond/dataSources+TLT394) and web-walk through delicious or other sources to find the right stuff for you. This is one of the biggest time
sucks of geospatial tools, but there's no easy, magical way through it short of changing topics to something with more accessible maps or data
fields.
4:20-4:30 = Jackie
4:30-4:40 = Megan
4:40-4:50 = Kristina E.
4:50-5:00 = Christina DiS
5:00-5:10 = Kylie F
5:10-5:20 = Kristen T
5:20-5:30 = Emily
5:30-5:40 = Jess M.
5:40-5:50 = AP O.
5:50-6:00 = Brian T.
6:00-6:10 = Jordie C.
6:10-6:20 = Farah V.
6:20-6:30 = Dana T
6:30-6:40 = Brittney B
6:40-6:50 = Jeni C.
6:50-7:00 = Greg F.
After class
Reading – think of these as examples of people assembling maps & datasets for their own particular instructional purposes. What resources did
they use to build their activities?
Shin, 2006
Edelson, Smith, & Brown, 2008 – you can get their My World file through here (right-click or Cntrl-click and save the file to your
computer, open in My World): http://www.uic.edu/educ/bctpi/historyGIS/greatmigration/GreatMigrationV42.m3vz
Assignments
WTL
Complete and turn in final Google Earth assignment

Session 6 - Thursday, 7 June
Before class
Complete readings
WTL
Complete and turn in your final Google Earth assignment docs
During class (ppt)
Housekeeping – questions / concerns about Google Earth assignment? How are we looking for the GIS assignment?
Conceptual work
Inquiry
What are we talking about? Let's try going outside to do an activity with stomp rockets. You'll need: Paper, pencil, GPS unit, and
a sense of competition.
Return inside & de-brief: How was that inquiry? What were the key features?
Why is inquiry learning so essential to working with geospatial tools?
An inside-the-classroom experience of inquiry: working with the Great Migration file from Edelson, Smith, & Brown. You'll need
the project file (uic.edu/educ/bctpi/historyGIS/greatmigration/GreatMigrationV42.m3vz ); note that if you just click on the link,
your browser may try to display the file. Instead, you should download it, open My World, then load the data from inside My
World with File > Open.
Your task: Either support or revise the following definition: "Great Migration, n. the large-scale movement of African
Americans from the South to Northern cities in the early 20th century."
Use the dataset to test the definition
Decide to support it or revise it.
Generate one or more screenshots to support your position
Post a statement in your WTL thread giving your final position. Include your screenshot(s) as attachments.
Great Migration de-brief, pivot to the importance of scaffolding
Scaffolding
What are we talking about? Zone of Proximal Development, process of moving students toward independent application of
skills, internalization of mental models, etc.
Why is scaffolding such a big deal with geospatial tools?
Scaffolding in action: Trees, cars, and carbon activity. Identify the scaffolds being used
Scaffolding and inquiry in action: Environmental Literacy & Inquiry project. I've selected one curriculum (Energy) and just one
lesson (Oil) out of a total 40-lesson sequence.
Pair up as partners. One partners. One partner will do this in My World, the other half will do it in a new web interface.
For those working in the client-side GIS, you'll need this My World file: Oil_Map.m3vz. (Remember: Downloading My
World files can be tricky!)
For those working in the browser-based version, everything you need is here:gisweb.cc.lehigh.edu/energy.
Closure--re-visiting finding datasets. Problems? Questions? Aha! moments?

After class
Reading
Doering & Veletsianos, 2007 - JECR
(Also, if you didn't do it already: Check out Milson, Demirici, & Kerski Ch. 1; I'd also recommend looking at the last chapter.)
Assignments
WTL
Work on GIS assignment. Proof-of-concept due next Thursday!

Session 7 - Tuesday, 12 June
Before class
Complete reading
WTL
Work on GIS assignment
Play around with the Oil activity linked above. Don't spend too much time on it, but do try it out, both to observe the scaffold of the task and to
learn more about the tools involved.
During class (ppt)
Housekeeping
Sign up for Thursday meeting slots
Next Tuesday = meet at Broughal and, if you have an iPhone, have an app loaded.
Conceptual work
Web-based geospatial tools
What are we talking about?
Well, first let's observe one of our client-side tools as it grabs data from the web: Dynamic data links in Google Earth.
Where is this data coming from? Why does this matter?
Now let's go the other way: Take a client-side tool and stick it in the browser: Google Maps, individuals' maps, & mashups. As an example of a pretty hot new mash-up: Mapnificent. How is this like a GIS?
A counter-example: this is NOT what we're aiming for: US Holocaust Memorial & Museum - Holocaust History - Animat
ed Maps.
The importance of going online
What's awesome: Ubiquity, data-updating
What's less-than-awesome: Browser-/plug-in-dependence, locked-off datasets, designer-limited controls.
Let's discuss these trade-offs in the context of the Environmental Literacy & Inquiry project, using the Energy unit's
online map: gisweb.cc.lehigh.edu/energy.
A sampling of browser-based tools
Light-weight, mark-up and display only
Flickr world map, individual groups' maps (glaciers, just to pick one at random).
Heavier-duty, analytical tools
Fieldscope.us
Collaborative effort among National Geographic, ThinkFinity, and others. Note that this is where the
thinking behind My World has gone: Education Foundation Board.
Lots of static material, and look-what-we're-going-to-do stuff. Example of printable map builder: Map
Maker 1-page maps.
Heart = online datasets+world map: MapMaker Interactive.
Esri goes online
(First, know that the ELI materials you looked at last week are all a local install of these same tools.)
ArcGIS.com.
Like Fieldscope, voila an interactive map with different datasets to overlay on it.
Different from Fieldscope (at least as of June, 2012): Can create custom maps, don't just
have to use pre-existing content: Example custom map using our scaffolded geocache
dataset.
And now to pivot towards map design: Here's another map in ArcGIS.com, this time Civil
War Eastern Theater battlesites.
I want a basemap circa 1861...where can I get one???
I want a color scheme that doesn't go through something ridiculously lightcolored – how can I get one??
ArcWeb Explorer. (Note: When i try to launch it, I get an error message!)
VisualEyes. Sample project: Thomas Jefferson's travel and correspondence, spring of 1786. And here's how
things work on the back end, building the map+datasets that you see.
The future of geospatial tools = mobile, web-based; personalized?
Map design
Quickie overview of visual design
...apologies for repeating items from TLT 406, but they're necessary stage-setters
To discuss correlation vs. causation, in addition to Snow's cholera map, I'm lifting a map from this article about maps
and advocacy in The Economist.
Map design issues, examples
Lehigh Packer campus map.
I'm pulling some 'grids' from USGS.gov (with inspiration from Ann B.)
Subway maps
official map from MTA.
un-official map from SPUI.
Washington-area Metro map from WMATA.
Taxi maps from DC from designorati.

Closing discussion of false-color mapping, using this map from ESRI.
Warming up to maps and advocacy
Examples of (causal-use) geospatial / visualization tools, examples
Playing with space and time: animation of immigration, 1820-2007 (note that there ARE bugs/errors in this
thing)
Playing around with unconvention uses of data: "Seven Deadly Sins" visualizations from KSU (can also get
the dataset and documentation from same site).
Playing with perception
Jamestown maps
Conventional, old-school textbook view.
Jamestown in context of Native American settlements.
Even more context: similar info in a Google Earth overlay, courtesy of the Virginia Center for Digital
History's "Virtual Jamestown" project (UVA)
Maps of the Middle East
Mapping crime
Tampa, FL - Hillsborough County Sheriff's Office interactive map of crime.
http://www.familywatchdog.us/Search.asp: Wow. Just wow. Way to (a) strike at our paranoia while
(b) making a profit.
Closure
After class
Reading – omit for now, just focus on GIS assignment / final project
Assignments
WTL
work on GIS assignment
Sign up for Thursday meeting, if you need one
If you have an iPhone or iPad, please download and install ARIS: http://itunes.apple.com/us/app/aris/id371788434?mt=8

Session 8 - Thursday, 14 June
Before class
Complete reading
During class (ppt)
4:00-4:15 = Kristen T.
4:15-4:30 = Kylie
4:30-4:45 = Megan
4:45-5:00 = Jackie
5:00-5:15 = AP
5:15-5:30 = Farah
5:30-5:45 = Jess
5:45-6:00 = Kristina E.
6:00-6:15 = Emily
6:15-6:30 = Cristina DeS
6:30-6:45 = Jeni
6:45-7:00 = Greg
After class
Reading
Assignments
Session 9 - Tuesday, 19 June
Before class
Complete reading
Make sure you know where Broughal is! Be there at 4:00
During class (ppt)
Housekeeping
Conceptual work: Augmented reality (guest presentation by Denise Bressler)
Closure
After class
Reading – check out some of the projects from ARIS: http://arisgames.org/projects-and-papers/
Assignments: WTL, work on final project!
Sign up to tell me if you prefer to present next week on Tuesday or Thursday. I'll do my best to accommodate people's preferences.
Session 10 - Thursday, 21 June
Before class

Complete reading
During class (ppt)
Housekeeping – discussing presentations
Conceptual work: Spatial thinking, spatial tools
Continental drift in action: http://www.ucmp.berkeley.edu/geology/anim1.html
Example of dynamic earth: Yellowstone geysers in the very long view: http://www.nps.gov/yell/naturescience/tracking_hotspot.htm
Handy resource for more on cartograms: WorldMapper.org.
Focusing area of visualization techniques: Oil and gas exploration
Thumper truck in action: http://www.youtube.com/watch?v=3oYKqSP_nW0
Vibrator truck: http://www.youtube.com/watch?v=4El6U0XTNS0
Seismic exploration at sea (this time from the corporate viewpoint, specifically Shell Oil): http://www.youtube.com/watch?
v=L_a06pXG2zU
Simpler example: Civil engineering: using above techniques to locate water pipes under road: http://www.youtube.com/watch?
v=KnZQVZAqE3w
Closing resource – spatial and temporal, but not geospatial: gapminder.org.
Closure
After class
Reading = (none, just work!)
Assignments
WTL
Work on final project. If you're presenting on Tuesday (see below), prepare and upload your files!!
Session 11 - Tuesday, 26 June
Before class
Complete reading
During class (ppt)
Housekeeping
Presentations
Emily
Kylie
Megan
Greg
Jeni
Jess
Dana
AP
Closure
After class
Reading
Assignments
Session 12 - Thursday, 28 June
Before class
Complete reading
During class (ppt)
Housekeeping
Presentations
Christina DeS.
Farah
Jackie
Brittney
Brian
Jordie
Kristen T.
Kristina E.
Closure
After class
Reading
Assignments

...go back to top?

end

